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‘ Projects

Hair today, gone tomorrow

Give people funny hairstyles by creating a web app
with JavaScript

Step1 Introduction

Write an online app to give people funny celebrity hairstyles with JavaScript!

This resource is based on an original idea (https:/www.youtube.com/watch?v=ghH49ngPFo0&feature=youtu.
be) by winning Pioneers team PiCymru for the Make us laugh challenge.

What you will make
Use the sliders to move and shape the hairin order to position it on the person’s head.
What you will learn

This project covers elements from the following strands of the Raspberry Pi Digital Making Curriculum (http:/rp
fio/curriculum):

e Combine 2D and 3D assets in the assembly of a project (https://curriculum.raspberrypi.org/design/build

er/)

* Apply basic programming constructs to solve a problem (https://curriculum.raspberrypi.org/programmi

ng/builder/)

e Engage and share with the digital making community (https://curriculum.raspberrypi.org/community-an
d-sharing/creator/)

Additional information for educators

If you need to print this project, please use the printer-friendly version (https://projects.raspberrypi.org/en/pro
jects/hair-today/print).

Use the link in the footerto access the GitHub repository for this project, which contains all resources (including an
example finished project) in the ‘en/resources’ folder.
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Step 2 What you will need

Hardware
e Acomputer capable of accessing the trinket.io (https://trinket.io) website
Software

This project can be completed in a web browser using the following sites:

e trinket.io (https://trinket.io)

¢ Pixlrimage editor (https://pixlr.com/editor/), which requires Flash player (https://helpx.adobe.com/flash-

player.ntml) to be enabled and unblocked

If you have otherimage editing software which supports layers and transparency (e.g. GIMP, Inkscape, or Adobe
Photoshop), you can use that instead of PixIr.

Additional resources

¢ Photographs of celebrities with hairstyles you like, or other appropriate images
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Step 3 Findanimage

To begin, you will need to find two images: an image of a celebrity or person with the hairstyle you want to use in
your project, and an image of the person you want to give the hairstyle to.

When you are looking for an image, you need to think about:

e How large the image is — images that are too small will not look good
e Whetheryou have permission to use the image

Forexample, here you can see three images. The image on the farleft is clear, and the subject was obviously aware
that the photo was being taken. The centre image is of a low quality and heavily pixelated. The image on the right
was taken without the subject being aware that he was being photographed, and he would probably not consent to
it's use.

* Agood place to look for pictures online is Wikimedia Commons (https://commons.wikimedia.org/wiki/Main
_Page), where there are lots of images available under a Creative Commons license.

e Finding images with permissions to use

Because of copyright law, you cannot use everything you find on the web. Here you will learn how to find images
that you can use in your digital making without breaking copyright laws.

Understanding copyright law

Copyright law is designed to protect creators of artistic, literary, musical, and dramatic works from having their
work exploited or misused. This means that copyright law applies to all manner of materials offline and online,
including images and art work.

Anyone who uses a copyrighted work without the owners’ permission is guilty of copyright infringement. This is
sometimes true even if a lot of things have been changed about the work.

Many images on the internet are protected by copyright. The copyright symbol © does not have to be present in
the image for copyright to exist.

If you want to use an image for which you require permission, you will need to obtain permission from all the
copyright owners. Otherwise, you can search forimages that are free foryou to use through Creative Commons
licensing.

Creative Commons
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Creative Commons licensing allows the creator of an image to select which permissions they want to give to
people to their work for free. With Creative Commons licensing you can give away all rights to your work, or just
some of them. There is an online form on the Creative Commons website (https://creativecommons.org/)

that helps you to figure out exactly which of yourrights you want to give away.

Creative Commons licensing makes it easier for people to find images that they have permission to use. On the
Creative Commons site, there is a search tool (https://search.creativecommons.org/) you can use to find
images that have a Creative Commons license. Another good place to look forimages available under a Creative
Commons license is Wikimedia Commons (https:/commons.wikimedia.org/wiki/Main__Page).

Many search engines also feature a way to search forimages with a Creative Commons license, so that people
can avoid breaking copyright law.

Searching for images with Google
If you are using Google, follow the instructions below to find an image you can use in your digital making:

» Goto Google Images and type in what you are searching for. Here, we searched for cat fail:

e @ a
oogle

e (Clickon Search Tools, then Usage Rights, and select Labeled for reuse.

Go gle cat fail a Y Qa

Al Images  Videos  Shopping  News  More Settings | Tools

Sizev  Colorv  Typev  Timev  Labeledforreusev  Moretools¥  Glear

Notfiltered by license
ﬂ m ﬂ M ebeted forreuse win modiieaton ‘ n

v Labeled for reuse

Labeled for noncommercial reuse with modificatior

Labeled for noncommercial reuse

e Choose an image.
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* Double-check whetherit is free to use. You can use a reverse image search tool like TinEye (https:/www.ti
neye.com/) orlmage Raider (https:/www.imageraider.com/) to check for any further usage rights. Here,
| copied the image link from the Google search, pasted it into TinEye, and pressed Search. As you can see,
the image has been used many times (781!) all overthe internet, so it is likely that it is free to use. If in doubt,
you should write to the ownerand ask for permission.

inEye (6

781 results

Searched over 24.6 billion images in 1.3 seconds.
for: https://c1.staticflickr.com/1/238/455879410_e281cf087f.jpg

Show only the 19 results found in collections.

JPEG, 446x354, 50.1 KB

Online safety

If you accidentally discover an image you find upsetting (https:/www.thinkuknow.co.uk/11_13/Need-advi

ce/Things-you-see-online/), close your browser immediately and tell an adult.
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Step 4 Edit the hair

For now, we will use this image from Wikimedia Commons (https://commons.wikimedia.org/wiki/File:Quiff _hai
rstyle_-_01jpg):

Thisimage hasa CC-BY-3.0 license (https://creativecommons.org/licenses/by/3.0/deed.en), which means
we can use, alter, and share the photo as long as we credit the original person who took the photo. You can credit
the person simply by adding theirname and a link to the license where you share the image, like this:

By Tim Lucas CC BY 3.0 [(http:/creativecommons.org/licenses/by/3.0), via Wikimedia Commons

* Choose yourtwo images, one containing a hairstyle and the othera photo of the person you would like to put
the hairstyle onto. Save the images into a folder on your computer.

¢ Open up PixIr (https://pixir.com/editor/), which is a free online image editor. If you have access to another
image editing tool that you prefer, you can use that instead.

¢ Select Openimage from computer or Open image from URL from the menu, and select the image
containing the hair style you wish to use, or copy in the url of the image you want to use..
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CREATE A NEW IMAGE
Start with a blank imape or one from the clipboard

OPEN IMAGE FROM COMPUTER
Browse your computer to select an image

OPEN IMAGE FROM URL
Specify an URL of an image to fetch

OPEN IMAGE FROM LIBRARY
Images from pixir, facebook or other library

¢ Usingthe lasso tool, draw a rough outline around the person’s hair. It doesn’t matter at this stage if you also get
some skin or some of the background — we will remove that in a minute.

ul-y
[0l ¥

2@ hic®/

p >

e PressCtrl + Ctocopythe hair.

e Click File >New image, and click OK on the box that pops up.

File Edi Image Layer Adju

Open image. ..

Open image URL ..
Open image library...

e PressCtrl + Vtopastethe hairintothe newimage.
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Untitled

¢ Now you need to remove the background. In the layers palette on the right, double-click on the padlock next to
the Background layer. This will unlock that layer.

* To remove this layer, press the key on your keyboard marked Delete (NOT the backspace key), or go to Edit >
Clear on the menu. The background of the image will change to a checkerboard pattern, which means that the
area is transparent.

Untitled

Let’s tidy up the messy bits of background around the hair.

e Switch backto Layer1by clicking on it in the layers palette.
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¢ Click on part of the green background you want to remove. It will become highlighted with a wiggly line around
the edge. You can now press the Delete key to remove it.

¢ To make your magic wand select more of the green background, you can change its tolerance setting. Alow
tolerance means that the wand will only select areas of colour that are very similarto the colour you clicked on.
The higherthe tolerance, the less strict the wand's selection. Tolerance ranges from O to 255.

File Edil Image Layer Adjustment Filter View Languag

Tolerance: 46 ~ v Anti-alias Vv Contiguous

¢ Remove as much of the background and the skin as you can, taking care not to delete any of the hair. You will
be left with a few annoying bits hanging around.
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Untitled

e PressCtrl + Dtodeselect any areasthat might still be selected by the magic wand. You want nothing to be
selected, so check that you see no wiggly lines anywhere on the image.

¢ Select the erasertool and carefully remove any leftover areas around the hairthat the magic wand missed. To
make it easier to remove the small bits, you can change the size and shape of your eraser by clicking on the
Brush.

File Edi Image Layer Adjustment Filter Language
§  Brsh: P Opacity: 100~

15 20 30
25 30.

7 ] 15

o/

60 85 20

S IO Rl

@ ¢

¢ Once you are satisfied, click File > Save. In the box that appears, give your file a name. Make sure you select PNG
as the file type so that yourimage will be saved with a transparent background.

Save image

Format:
PNG (Transparent, full quality)

¢ You should now have a finished hairstyle with a transparent background.
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Step 5 Addtheimages

e Open upthe startertrinket rpf.io/combover (http://rpfio/combover).

You will see some HTML code in the index.html tab and some CSS code in the style.css tab.

= Ptrinket < sutonn o«

€ > indexhtml style.css

¢ Click on the image icon in the top right-hand corner of the code area.

+ B

¢ Click Add image, then Upload, then Click to select files. You will need a free Trinket account to be able to
upload images.

¢ Select the hairimage you just made and the image of a face you picked out earlier.

Wait forthe images to upload, then make sure that both are selected in green so that you can use them in this
trinket.

Make a note of the file names of the images — in this example, we have face. jpgand quiff.png.

| am using a photo of myself, so | know that | have permission to use it and that | am happy for it to be seen in public
on the internet.

e Gobacktoindex.html andlook at the code on lines 9 to 15.

e Hereisa good place to add the image license. You can add a comment in your HTML code between <! --and -
-> to place the license text foryourimage:

<div id="hair"> <!-- Hair image by Tim Lucas CC BY 3.0, via Wikimedia Commons -->
<img src="" id="hair-image">
</div>
Where you see src="""in the code, you need to add the name of the picture you want to display between the

guotation marks.

¢ Addthe file name of your face image between the quotation marks of the first image tag.

g- <div 1d="original”>
10 <img src="face.jpg">
11 </div>

¢ In exactly the same way, add the file name of the hairimage inside the second image tag.
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You should see both images appearin the area to the right of the code area. However, the hair might be floating
around somewherel
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Step 6 Addaslider

Let's add a slider so that the user of your app can change the width of the hairto make it fit on the pictured person'’s
head properly.

e Clickon line 18, which is inside the <d1iv> labelled sT1iders.

A <div>is an invisible box which can be moved around and positioned on the page.

¢ Addthe following code to create a width slider on your page that allows you to control the width of the hair
image so you can fit it onto the head.

Width: <input type="range" min="1" max="300" value="50" id="hairwidth">

You should see the slider appear below your picture.

If you move the slider at the moment, nothing happens. You need to write some code to tell the page: “When this
slideris moved, change the width of the hair”

» Position your cursor between the <script>and </script> tags. This is where you can write JavaScript
code.

e Create avariable called width_s1ider, which refers to the slideryou just added, like this:

var width_slider = document.getElementById("hairwidth"”

Notice that the id of the slideryou just created is hairwidth, and now you're using it to select the slider with the
help of getElementById.

¢ Below this line, but still within the <script> tags, add the following code so that the width of the hair
changes wheneverthe slider's value changes:

// When I move the width slider...

width_slider.oninput = function
// Change the width of the hair
document.getElementById("hair-image").style.width = this.value + "px"

This code says “When the width_sTider is moved, select the hair-image and set its style.width tothe value

of the slider (this.value+"px")" You use // to tell your JavaScript code that what follows isa comment.

e Move the slider — as you do, you should see the hairimage get bigger or smaller.
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Step 7 Challenge: change the height

Can you add another slider to allow people to change the height of the hairimage? You will need to follow these
steps:

* Create anothersliderinside <div id="sTliders"> by copying and pasting the code forthe width slider. Don't
forget to change the label and the id of the new slider.

* Between the <script>tags, add a variable that refers to the id of the slideryou just created.

¢ Add some more JavaScript code to say “When the height slideris moved, change the height of the hairimage”
You will need to change the code in the two places marked with 7?7 below. Look at the code you wrote earlier

to help you.

???.oninput = function
document.getElementById("hair-image").style.??? = this.value + "px"

e Test whetheryourcode works. Can you move the sliderto change the height of the hairimage?
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Step 8 Changethe position

Now that you can change the width and height of the hairimage, let's also make it possible to change its position
so you can perch it perfectly on top of the head you picked out!

The process is almost the same as forthe width and height of the hair, with only one small difference. When you
changed the width and height of the hair, you were modifying the <img> with the ID hair-image:

To move the hairaround, you will need to modify the <d1iv> with the ID hai r instead.

¢ Add code fora top slider below to the code forthe other sliders — this will control how far from the top of the
page the hairimage is located.

Top: <input type="range" min="1" max="300" value="50" id="hairtop">

* Between the <script>and</script>tags, create a variable called top_s1ider to referto the slideryou
just added:

var top_slider = document.getElementById("hairtop"

* Move your cursor so that it is below this line, but still within the <script> tags. Add some code to change the
hair's distance from the top of the page wheneverthe top slider's value is changed. This time we will select the
hair element instead of the hair-pic.

top_slider.oninput = function
document.getElementById("hair").style.top = this.value + "px"

Take care to add this new code after the closing brackets of your existing code, ratherthan inside them.

¢ Move the slider. You should see the hairimage move toward or away from the top of the page.

e Adda left sliderin exactly the same way: repeat the same steps but replace top with Teft everywhere you
put it to allow your hairto be positioned at variable distances from the left of the page.

e Use the sliders to position and resize the hair so that it looks like it belongs to the person in the picture.

To save your picture, you can press the Print screen button (on a Windows computer) or Command + Shift + 4
(on Mac). Then paste the image into your favourite image editor to crop and save it.
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Step @ Challenge: rotate the hair

» Canyou add a slider which allows you to rotate the hair <div>?

You can follow the same procedure you used to add the top and left sliders, but you will need a different command
to tell the hairto rotate:

document.getElementById("hair").style.transform = "rotate(" + this.value + "deg" +")";

Don't forget that the sliders currently have a minimum value of 1and a maximum value of 300. How will you need to
change this for your rotation slider so that you can rotate the hairin a full circle?

Left: <input type="range" min="1" max="300" value="50" id="hairleft">

Now you can give the people in your pictures funny beards tool!

¢ (Can you add more hair choices? Find anotherimage and edit it to remove the background as you did for the hair,
then add it to yourtrinket. Perhaps this time you could add a moustache or pigtails?

Published by Raspberry Pi Foundation (https:/www.raspberrypi.org) under a Creative Commons
license (https:/creativecommons.org/licenses/by-sa/4.0/).
View project & license on GitHub (https:/github.com/RaspberryPilearning/hair-today),
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